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Thank You !! for purchasing your new Software Control Application from PESA. We appreciate 
your confidence in our products. PESA produces quality, state-of-the-art equipment designed to 
deliver our users the highest degree of performance, dependability and versatility available anywhere. 
We want you to know that if you ever have a concern or problem with a PESA product, we have a 
team of engineers, technicians and customer service professionals available 24/7/365 to help resolve 
the issue.  
 
Our commitment is to continue earning the trust and confidence of our customers throughout the 
industry by incorporating cutting-edge technology into the highest quality, most cost effective products 
on the market. And we would like to invite you to tell us how we’re doing. If you have any comments 
or suggestions concerning your PESA equipment, please contact our Customer Service Department. 
 
Again thank you for choosing a PESA product and we look forward to a long-term partnership with 
you and your facility. 
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Chapter 1 About This Manual 
 

1.1 DOCUMENTATION AND SAFETY OVERVIEW  

This manual provides instructions for installation and operation of the Cattrax System Control 
Application for the Windows® operating system, designed and produced by PESA. 

It is the responsibility of all personnel involved in the installation, operation, and maintenance of the 
equipment to know all the applicable safety regulations for the areas they will be working in. Under no 
circumstances should any person perform any procedure or sequence in this manual if the 
procedural sequence will directly conflict with local Safe Practices. Local Safe Practices shall remain 
as the sole determining factor for performing any procedure or sequence outlined in this document. 

1.2 CAUTIONS , AND NOTES 

Throughout this document, you should notice various Cautions and Notes. These addendum statements 
supply necessary information pertaining to the text or topic they address. It is imperative that audiences 
read and understand the statements to avoid possible loss of life, personal injury, and/or 
destruction/damage to the equipment. These additional statements may also provide added information 
that could enhance the operating characteristics of the equipment (i.e., Notes). Examples of the graphic 
symbol used to identify each type of statement and the nature of the statement content are shown in the 
following paragraphs: 
 

1.2.1 CAUTION  

 

Caution statements identify conditions or practices that can result in 
personal injury and/or damage to equipment if the instructions contained in 
the statement are not complied with. 

 

1.2.2 NOTE 

 

Notes are for information purposes only. However, they may contain 
invaluable information important to the correct installation, operation, 
and/or maintenance of the equipment. 
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Chapter 2 Introduction 
 

2.1 DESCRIPTION  

PESA’s Cattrax is a software application, for use on a compatible PC running the Microsoft Windows® 
2000, XP, Vista or Windows 7 Operating System, to monitor and control a variety of PESA products.  
Cattrax allows users to retrieve real-time information about the operational status of controlled devices 
such as QFX Series modules, PESA routers, control panels and processing frames and cards within the 
facility network.  Users can also configure and monitor status of multiple PESA devices.   

Cattrax communicates with external managed devices over an Ethernet link, by using the Ethernet 
function of the host PC for communication with system components.  Cattrax can also communicate 
with compatible PESA devices, one at a time, using a USB port of the host PC.  Network and USB 
connectivity may be used simultaneously.   

This versatile software application greatly enhances system integration possibilities for any PESA 
installation.  Virtually any PC within your local area network (LAN) becomes a feature rich control 
panel for your PESA devices.  Users familiar with menu-driven and graphical user interface (GUI) 
based software control applications will feel right at home with Cattrax.  Figure 2-1 illustrates a typical 
screen layout of the Cattrax application.   
 

 

 
Figure 2-1  Cattrax Screen Layout 
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2.2 CATTRAX CONTROLLER FEATURES 

• Automatic Device Discovery and Display - Automatically “discovers” PESA devices and 
control panels operating over the facility’s internal network or connected through a USB port of 
the host PC, and displays located devices in a hierarchical tree structure to provide a global 
view of the system.  The entry for a device “discovered” through the USB port is displayed in 
the device tree with a USB icon overlay to differentiate it from network devices. 

• Alarm Monitoring  – Monitors alarms and events from the discovered devices, and displays 
them in a table format. Table columns may be sorted to make search and diagnosis of reported 
alarms and events faster and more convenient.   

• Menu Driven Configuration and Control  – Uses a standard Windows® operating system tree 
structure for quick access to menus, current configuration of multiple devices may be displayed 
simultaneously, reconfigured and controlled in real-time to optimize processing functions of 
cards.  

• Configuration Management – Helps users manage the configuration of their system more 
quickly and effectively. It allows configuration of individual cards or frames; or the entire 
system configuration may be saved to a file, and then restored by the user when needed. Cattrax 
also supports automatic configuration restoration for cards in a frame. 

• Remote Access over VPN – Network parameters can be configured to allow use of Cattrax 
over a VPN link. 

• Automated Batch Firmware Download – Allows you to download software or firmware code 
updates to multiple devices of the same type simultaneously. 

• Demonstration Mode – Allows you to fully simulate operation of various menu screens for a 
variety of PESA equipment without affecting any changes to actual equipment connected to the 
network.  This feature is invaluable for learning available control and monitor functions for 
specific devices, or for training operators who may not be familiar with Cattrax how to navigate 
and operate various functions of the application. 

• Password Control – May be used in no-password or password control mode. In password 
mode, users are required to login in order to change controls and operational parameters 
contained in system configuration menus. 

 

2.3 DOCKABLE WINDOW PANELS 

Various window panels displayed by Cattrax, such as Alarms & Events, Menu Tree, etc, are dockable, 
and may be moved and re-docked to any position preferred by the user. As an example, Figure 2-2, 
shows the Alarms & Events panel moved to the top part of the screen from the bottom, and the Menu 
Tree moved from the left side to the right.  Any time the software is closed, Cattrax saves the current 
screen layout and displays the same layout when restarted.  

Screen position of the Menu Tree selection is global across all the cards. For example, if the menu tree 
is moved from left to right for the device named “Vidblox Rx One,” as shown in Figure 2-2, all new 
cards or devices opened after the change will display their menu tree on the right.  

You may restore the screen layout to the default appearance at any time by clicking on the Default 
Layout selection in the View menu.  
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Figure 2-2  Cattrax with Reconfigured Window Positions 
 

 

2.4 HARDWARE SYSTEM REQUIREMENTS  

Cattrax requires a PC running the Microsoft Windows® 2000, XP, Vista or Windows 7 Operating 
System, with a minimum of 512 MB RAM.  The entire application requires approximately 60 MB of 
disk space on a local drive.  
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Chapter 3 Installation 
 

3.1 CATTRAX INSTALLATION  

Cattrax is a graphical user interface (GUI) type software application for use on a standard PC running the 
Microsoft Windows® 2000, XP, Vista or Windows 7 Operating System. The PC must have a CD-ROM 
drive for installation of Cattrax and, in order to connect with PESA devices communicating over the facility 
network, must have wired or wireless access to the local area network (LAN).  A mouse with scroll-wheel is 
recommended for precise control of device parameter values using slider controls, and a monitor size of 19 
inches or larger is also recommended.   

3.2 INSTALL CATTRAX PROGRAM AND DATA FILES  

Your Cattrax installation disk contains an auto-run file that guides you through the installation process.  
Examples of the pop-up screens you will see are shown below with the appropriate step.  Notice the “X” 
used in place of actual values on each example screen presented here.  During installation the release 
number of Cattrax software you are installing is displayed.   

Install the Cattrax software application as follows: 

1. Insert Cattrax CD into CD Drive of host PC.   

2. Allow the disk to initiate the auto-run function.  
When initialization is complete, the banner, as 
shown at right, is displayed on the desktop.  Click 
Next to begin installation of the Cattrax application.   

3. If the auto-run function does not automatically 
launch, navigate to the directory of the disk drive 
containing the installation CD and double click the 
Cattrax.exe file.  The banner shown at right should 
be displayed on the desktop.  Click Next to begin 
installation. 

 

4. Read the license agreement and click I Agree to 
continue, as shown at left.  

 

 

 

 

  

5. The Choose Components window allows you to 
select the software components you wish to install.  
During initial installation, the only option is to 
install the entire program.  Ensure that the box next 
to “Cattrax” in the list box is checked. 
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6. If you want to install the USB port driver, also check the “PESA QFX Driver” box  

7. Click Next to continue installation. 

 

 

8. By default auto-install creates the folder shown 
at left for the Cattrax application.  If you wish to 
install the software in a directory or folder other 
than the default, click Browse and navigate to 
the destination.  Click Install  to continue 
installation.   

 

 

 
 
 
9. Once Cattrax is installed, you will receive the 

prompt to install the QFX USB driver.  Click 
“OK” to install the driver.  If the QFX USB 
driver is not present on the host PC, Cattrax 
will not be able to communicate with a 
connected device through the USB port. 

 

 

 

10. You may accept the default installation 
location, as shown at left, or browse to 
another folder in which you wish to install 
the QFX USB driver.  When the destination 
folder is correct, click the Install button to 
proceed with driver installation. 

 

 

 

 

11. You may receive a message indicating that the 
software has not passed Windows Logo testing, 
as shown at right.  The USB driver files have 
been thoroughly validated.  Click “Continue 
Anyway” to continue. 
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12. You will see the screen at left as installation 
continues. 

 
 
 
 
 
 
 

 
 

13. When driver installation is complete, you 
will receive a prompt indicating that the 
installation was successful, as shown at 
right.  Click “OK” to continue to the 
“Installation Complete” prompt.     

 
 

14. Click Finish to exit the installation process.  
During installation a shortcut icon to launch 
Cattrax is automatically placed on the desktop.  If 
the box next to “Run Cattrax Release X.X” is 
checked, the application will start immediately.   

 

 

 

 

 

3.3 REMOVING CATTRAX INSTALLATION  

Should it ever be necessary to remove Cattrax 
from the PC, the uninstall command is 
available through the Start menu of the 
Windows® operating system.  A prompt 
window as shown at right is displayed on the 
desktop.  Click Uninstall to complete the 
command.  
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3.4 CONNECT A PESA DEVICE TO THE HOST PC THROUGH A USB PORT 
If you wish to control a PESA device over a USB connection using Cattrax, perform the following steps to 
allow “Plug and Play” capability of the Windows® operating system to interface device hardware to host 
PC.   Typical USB connection is shown in Figure 3-1 using a Vidblox module as an example. 

  

 

1. Apply power to the device. 

2. Connect the supplied USB cable first to the 
device and then into an open USB port on 
the host PC, as shown by the illustration to 
the left. 

3. After a brief pop-up from the taskbar, the 
“Found New Hardware” window, as shown 
below, may appear on the monitor.   

 
 
 
 
 

Figure 3-1  Connecting Vidblox Module to Host PC 
 
 

 
 
 
 

 
4. Select the “No, not this time” option button and then 

click Next to continue. 

 

 

 

 

5. The Driver Installation screen, as shown to the 
left, prompts you for your choice of how to 
locate and install the hardware driver. 

 

6. Select the first option, “Install the software 
automatically (recommended),” and click on the 
“next” button to continue. 

 
 
 

 

This window only appears if this 
is the first power-up after USB 
driver installation  

Host PC Running 
Cattrax Application 
with QFX Device 
Driver Installed

POWER
SUPPLY
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7. You will receive a message indicating that the 

software has not passed Windows Logo testing, 
as shown to the right.  The USB driver files 
have been thoroughly validated.  Click 
“Continue Anyway” to continue. 

 

 

 

 

 

 

 

 

8. During driver software installation, the 
prompt screen shown to the left is displayed.  
The progress bar monitors the installation 
procedure.    

 

 

 

 

 

 

 

 

9. When hardware installation is complete, the 
completion screen, as shown to the right is 
displayed.  Click the “Finish” button to exit the 
hardware installation wizard.   

 

10. The Vidblox module should now be 
communicating with the host PC. 
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3.5 CONNECTING HOST PC TO MANAGED DEVICE USING DIRECT ETHERNET CONNECTION   

Communication between the host PC running Cattrax and an external managed device is conducted over an 
Ethernet link.  This link may be established directly between the host PC and a PESA device, such as a 
Vidblox module as shown in Figure 3-2; or each component of the managed system may communicate over 
the facility network.   

It is permissible to run Cattrax from a PC already installed on the facility network; or it may be desirable, in 
certain installations, to have the host PC dedicated only to running Cattrax.  When using a dedicated PC as a 
single control element, and a single controlled device, use a crossover CAT5E interconnecting cable, 
configured as shown in Figure 3-2.  This illustration shows the rear panel of a Vidblox module as an 
example.   

 

 

Figure 3-2  Direct Connection of Host PC to Managed Device   
 

 

3.6 NETWORKED HOST PC AND CHASSIS FRAME  

When multiple frames and control panels are used together, an Ethernet switch is required and used with 
standard Ethernet patch cables.  When using a switch, a crossover cable should not be used.  Connect a 
port on the Ethernet switch to an Ethernet port on the host PC using an Ethernet patch cable.  Connect a port 
on the Ethernet switch to the Ethernet port on each managed device in the system using an Ethernet patch 
cable.  An example of a networked system with two host PCs is shown in Figure 3-3.  
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Cattrax
Host PC Devices

Vidblox TX Module
CAT5E Cable 
(No Crossover)

Ethernet Switch
(User Supplied)

CAT5E Cable (No Crossover)
Facility
Network

Connection 
(LAN)

QuadBox TX Module

QuadBox RX Module

 

Figure 3-3  Connecting Multiple Host PCs and PESA Devices to a Local Area Network   
 

Every host PC running Cattrax and every managed device must be assigned a unique network IP address.  In 
many installations, you will need to consult your facility network administrator when adding hardware to 
the network or when the default IP address for any hardware must be changed. 
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Chapter 4 Operation 
 

4.1  INTRODUCTION  

With Cattrax running, the host PC appears as a component of PESA control hardware.  Just as with many 
other PESA control devices, communication with other panels and chassis frames is over a dedicated 
Ethernet link, or the facility LAN. 

The first step in preparing Cattrax for operation is to configure all system components to communicate over 
the Ethernet network.  This requires assigning and, if necessary, changing the IP address of system 
components.  

When any Ethernet devices are connected to a network using an IP protocol, each device must have a 
unique IP address assigned.  If your installation requires including PESA hardware devices into an existing 
facility LAN, you will need to consult your network administrator for the proper IP addressing scheme to 
use for each device in the system.   

4.2 NETWORK CONFIGURATION  

In order for Cattrax to communicate with PESA equipment, the network interface device used by Cattrax 
must be actively connected to the subnet, or multiple subnets, containing equipment you wish to control.  
Figure 4-1 illustrates a typical single subnet network installation with the PC running Cattrax connected to 
an existing switch that connects control panels and frames. 

 

 

 

Figure 4-1  Cattrax Installation with Devices on Same Subnet 
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When communicating on a subnet containing PESA network controllable devices, Cattrax should 
immediately begin the discovery process for all devices configured for the same subnet.  In many 
installations, PESA devices may reside on subnets different from one another within the network. Cattrax 
allows you to easily select both the network interface device it uses and the subnets on which it 
communicates. To view or modify current network communication parameters for Cattrax, click the 
Network Preferences icon under the Setting menu in the Cattrax menu bar to open the Host Network 
Configuration screen as shown here. 

 

 
 

 
The upper area displays by IP address and name the network interface devices available to Cattrax.  In many 
installations there will be only one entry in the window and by default this would be the device used by 
Cattrax.  If there are multiple entries, as would be the case, for example, if the host PC contains both an 
Ethernet NIC and a wireless adapter, the device Cattrax is currently communicating through is shown 
highlighted.  You may select the network interface device you wish Cattrax to use by double-clicking the 
entry in the listing.  Be sure that the network interface device you select is communicating over the 
subnet(s) containing all PESA devices you wish to control.   

Subnets currently available to Cattrax are listed in the middle area of the screen under the Broadcast 
Address column.  A check in the box beside an entry indicates that Cattrax is actively communicating over 
that subnet and will automatically discover PESA devices on the subnet.   If you wish to prevent Cattrax 
from communicating over a specific subnet, click the checkbox to remove the check.  If you need to add 
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additional subnets or modify address parameters of currently available subnets use the buttons to the right of 
the display window as follows: 

• Add – allows you to add subnets to the list of those available.  Clicking the Add button opens the 
screen shown here. 

 

 
 
 

Enter the IP and Subnet  Mask data for the subnet address you wish to add.  You may use the text 
box at the bottom of the pop-up to enter a description of the subnet. Click OK  to enter the 
parameters.  The new entry is added to the listing and the checkbox will be checked to activate the 
new subnet. 
 

• Edit  – allows you to modify address parameters of any entry in the listing.  Highlight the entry you 
wish to modify and click the Edit button.  The Subnet menu is displayed with current parameters for 
the entry listed.  Make any changes you wish and enter OK to commit the changes.   

 
• Remove – allows you to remove any subnet from the listing.  Highlight the entry you wish to delete 

and click the Remove button.  The entry is immediately removed from the listing. 
 

The lower area of the screen contains a checkbox that allows you to disable the Multicast device discovery 
function that allows Cattrax to automatically locate PESA devices in multiple subnets. Default selection for 
this function is Enabled as indicated by a check in the box.  This option should not be disabled under 
normal use.  Multicast discovery should be disabled only if Cattrax is not required to discover devices in 
the local subnet (the same subnet as the PC running Cattrax).  If it is ever necessary to disable Multicast 
capability, click the checkbox to remove the checkmark.  If Multicast is disabled, the local subnet entry in 
the subnet configuration window (middle area of screen) should be deselected as well.    

When you have the network parameters properly configured, click the OK  button to select the new 
configuration and exit the dialog box, or click Cancel to exit the box without making changes.  

 

4.3 GET ACQUAINTED WITH CATTRAX  

Double click on the desktop shortcut icon to start the Cattrax application. 
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A typical screen display of Cattrax is shown in Figure 4-2.  Note that the display is composed of a number 
of individual “panels” each of which displays various menus or operational data.  It should be noted that 
Figure 4-2 illustrates the default display set-up. However, Cattrax provides tools that allow you to customize 
the display to individual preferences.  For this reason your display may not appear exactly as the example 
screen shown here.  However, the function of each display panel is the same regardless of screen placement.  
Each display panel is briefly introduced in the following text.  
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Figure 4-2  Cattrax Panel Layout   
 

 
DEVICES VIEW PANEL  
 
The Devices View panel contains a display of PESA devices “discovered” on the network, or any single 
device connected through the USB port of the host PC.  Devices may be listed by IP address, device name, 
or device type.  The entry for a device connected through the USB port is displayed in the tree with a USB 
icon overlay to differentiate it from network devices.  This listing is also used to select the device to be 
controlled by Cattrax. 

MENU TREE PANEL  
 
Menu Tree displays a listing of menus and sub-menus for the device selected from the Devices View panel.  
Tree branching is controlled by clicking on boxes containing plus and minus signs in the listing, exactly as 
in a typical Windows® operating system based application. 

 
MAIN DISPLAY PANEL  
 
Operational characteristics, configuration, or controls for the menu item selected in the Menu Tree listing 
are displayed in the Main Display panel.  Control and display functions used in this panel follow standard 
Windows® operating system protocol. 
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DEVICE TABS  
 
When a device from the Devices View panel is selected (by double clicking entry in device listing), a 
Device Tab is automatically displayed for it above the main display panel area.  When a tab is displayed for 
a particular device, you may immediately select the device by simply clicking on the tab.  The Menu Tree 
display changes to reflect the new device selection.  

 
DEVICE PROPERTIES PANEL  
 
Operational characteristics for the device selected in the Devices View panel are displayed in this panel.  
Properties such as IP address of the device and other data related to selected device are displayed.    

 

ALARMS AND EVENTS PANEL  
 
Cattrax monitors status of all active devices listed in the Devices View panel.  Alarm conditions and other 
event flags are displayed in real-time.  When an alarm condition occurs, a prompt identifying the condition 
appears in the listing and a flashing icon appears on the Devices View panel.    

 

4.4  BOARD DEFINITION FILES  

 

 

The information in this paragraph is provided in order to better acquaint 
you with the Cattrax application. On initial instal lation, it should not be 
necessary to make any changes or additions to board definition files, known 
as BDX files, since Cattrax is shipped from the factory with all current BDX 
files installed.  You should only have to verify presence of a BDX file if you 
receive an error message during operation stating that a configuration file is 
not present for a managed device.  If you change a managed device in the 
future, it may be necessary to install a new or updated BDX file.  If you ever 
need BDX files, they are available from PESA Customer Service. 

 

In order for Cattrax to control an external device such as a PESA router, QFX Extender Series module, or 
signal processing card, the correct Board Definition File (BDX) for the card must be present in the 
BDXFiles folder under the Cattrax directory, as shown in Figure 4-3.  
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Figure 4-3  Directory Showing Location of BDX Files 

 

Each BDX file name is in two parts – a brief identifier of the device name and the version number of the 
software code loaded into flash memory of the device supported by the BDX file. For example, in order to 
control a DRS DXE frame loaded with software version 1.0.0.0 requires that BDX file 
DRSDXE_1.0.0.XML be present in the BDXFiles folder.  Note that only the first three digits of the 
software version number are relevant. New BDX files are released as required to support device software 
revisions or updates, and are available from PESA Customer Service.  The BDX file directory may store 
multiple BDX files to support devices of the same type that may be running with different software 
revisions; an example of this is shown in Figure 4-3 with multiple BDX listings for DVA617 signal 
processing cards with different software versions. Cattrax will automatically locate and use the correct BDX 
file for the selected device. 

All PESA BDX files end with the .XML extension. 

 

4.5 INITIALIZATION  

When Cattrax is started, the software executes a discovery process, as part of initialization, to determine 
PESA devices on the network, or any single PESA device attached to the USB port, available for control.  
When the process is complete, discovered frames, devices and cards are displayed as a tree listing in the 
Devices View panel. You can expand the tree nodes to show all frames and panels discovered by Cattrax, as 
shown by Figure 4-4. 

 

 

PESA Remote Control Panels, such as the RCP503, must have the correct 
software version installed in order to be discovered by Cattrax. 
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Figure 4-4  Example of Device Tree on Initial Startup. 
 

 

The device tree shows both active and inactive devices, with active devices shown in bold. Inactive devices 
are devices that do not respond to a ping request from Cattrax after discovery. It is possible to delete 
inactive devices from the device tree using the right-click menu when the device is selected. 

If Cattrax discovers more than one device with the same IP address, it shows all devices with that address as 
inactive. You can change the IP address of devices affected from the Device Properties panel to resolve the 
conflict.  IP address conflicts are also displayed by an entry in the Alarms and Events panel.  Once a conflict 
is resolved, click the Refresh button in the Devices View menu header to rediscover the devices.  If the 
discovered device has an IP address with a network address different from Cattrax, it also shows that device 
as inactive.  

Devices with major alarms reported in the Alarms and Events panel are shown in red.  
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4.6 CHANGING DEVICE IP ADDRESS 

Cattrax allows users to change an IP address of both active and inactive devices from the Device Properties 
panel shown below in Figure 4-5. This feature is particularly useful for devices that are inactive due to an IP 
address conflict with other devices, or having a different network address.  Cattrax allows you to correctly 
set the IP address of such devices directly without having to isolate the device from the network.  

To change networking parameters for the selected device, simply enter the desired IP address, Subnet Mask 
or Gateway address in the boxes contained under the IP Address panel on the Devices Properties panel and 
click Apply . 

 

 
 

Figure 4-5  Changing IP Address from Device Properties Panel 
 
 
 

 

Operation of the change IP address feature requires support from software 
in the target device. If not supported by the device, the feature is 
automatically disabled by Cattrax 

Specific PESA devices, such as Vidblox modules, may have other IP 
configuration methods in addition to using the Device Properties menu.  If 
you have such devices in your system, the alternate network configuration 
methods are presented and discussed in the User Manual for the particular 
device. 
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4.7 CONTROLLING  DEVICE TREE DISPLAY  

The header area in the Devices View panel provides a number of controls related to display of devices in the 
device tree.  

Clicking an icon shown in Figure 4-6 initiates the following action: 

Refresh
View

Batch
Configure

Locate
Device

Offline
Configuration

Alarm
Alert  

Figure 4-6  Devices View Controls 
 

• Refresh View – Restarts discovery of network devices and updates the device tree.  

• Batch Configure – Puts multiple cards of the same type in Batch Configuration mode, refer to 
Paragraph 4.14.  

• Locate Device – Highlights currently selected device in the Device Tabs.  

• Offline Configuration  – Allows you to create or modify configuration files for PESA system 
controller devices without Cattrax having to be attached to the device.  

• Show All - Is a drop-down menu that allows you to select whether the display lists only active 
devices, or both active and inactive devices.  

• By Name – Is a drop-down menu that allows you to select how devices are displayed in the 
device tree - by their name, by their IP address, or by their type. Selection of the same option, 
for example By IP, changes the display order from ascending to descending or vice-versa. 

• Alarm Alert  – Is a flashing display to indicate presence of an active alarm alert in the Alarms 
and Events panel.  

4.8 DEVICE MENU DISPLAY  

To display the configuration menu of a device listed in the device tree, double-click on the device name in 
the Devices View panel. Cattrax displays a menu tree of the device selected in the Menu Tree panel, and 
displays content of the first menu in the Main Display panel, as shown in Figure 4-7. 

A device menu may also be opened from the Alarms and Events panel by double-clicking the entry for any 
device reporting an alarm condition.  

 

 
A device must be active in order to be opened. 
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Figure 4-7  Display Of Device Opened In Device Menu Window  
 

Menus and sub-menus are contained in the Menu Tree panel for a selected device. Double clicking on the 
menu expands it to show menus and sub-menus under it. Single clicking on a menu heading in the tree 
displays device parameters associated with the selected menu, and current values and status obtained in real-
time from the device.  

Functions performed by icons located in the header area of the Menu Tree panel are specific to the selected 
device, refer to Figure 4-8. 

 

 
 

Figure 4-8  Menu Tree Header Content 
 

• Refresh – Allows retrieval of control parameters associated with a selected menu in the menu 
tree and updates the display  

 
• Cancel – Allows you to cancel retrieval of data for a currently selected menu. This could be 

used if Cattrax is experiencing problems communicating with the device  
 
• Help (?) – Displays information about a selected device. If the help icon is grayed out, it 

indicates that no information is currently available for that device 
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4.9 CONFIGURATION AND CONTROL  

When menu content is displayed in the main display panel, use the various controls, sliders, radio-buttons, 
etc. to change parameter values.  Figure 4-9 is an example screen showing various types of controls you 
may see in a typical Cattrax menu screen.  

Tips:  

To achieve finer changes to parameter values when using a slider control, point the mouse to the slider 
on the slider bar, and then use the mouse scroll wheel. 

To reset individual controls right-click on the control and select Reset.   

 

4.10 TILE DISPLAY OF MENUS 

To facilitate faster configuration of devices, Cattrax allows simultaneous display of up to four menus in tile 
mode as shown in Figure 4-10.  To display in tile mode, open up to four selected devices and select either 
Tile Horizontally  or Tile Vertically  from the View menu in the main menu bar.  If menus for more than 
four devices are already open, close tabs of devices not required for tiling then select the tile display mode. 
Maximize any tile, or open another device from the device tree, to return to tabbed display.  

 

 
Figure 4-9  Example Control Display Screen 
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Figure 4-10  Example Tile Display of Device Menus 

 

4.11 DISPLAY PANEL AUTO-HIDE  

Cattrax allows you to create a larger work space by using the auto-hide feature available on the Devices 
View, Device Properties, Menu Tree and Alarms & Events display panels.  With auto-hide active, the 
display panel is hidden and replaced by a tab attached to the side of the main display panel.  Moving the 
cursor over the tab returns the menu to the screen and removing the cursor causes the display to once again 
hide from view.  Clicking on the tab of a hidden display panel returns it to the screen and selects it as the 
active menu as indicated by the orange highlight in the header bar.  The screen remains visible until another 
display panel is selected as the active menu.  You may activate this feature for any desired display panel by 
clicking on the Auto-Hide Icon, as shown by Figure 4-11.  To disable auto-hide, restore the display panel to 
screen and click the auto-hide icon.    

 
Figure 4-11  Auto-Hide Icon Location 

 

4.12 ALARMS &  EVENTS MANAGEMENT  

All alarm and event (non-alarm) messages for devices in the managed system are displayed by the Alarms 
& Events panel as shown in Figure 4-12.  There are two main types of alarms – System alarms and Device 
alarms. System alarms are generated by Cattrax, while Device alarms are generated by the devices managed 
by Cattrax.  
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4.12.1 ALERTS 

When a major alarm is reported by any device in a managed system, Cattrax displays an alert in the form of 
a flashing red dot in the Devices View panel header area. This ensures that even if the Alarms and Events 
panel is closed, the user is notified of the occurrence of a major alarm.  Should Cattrax be minimized, the 
Cattrax entry in the Windows® operating system taskbar is highlighted to alert the user.  

 

 
 

Figure 4-12  Cattrax Alarms and Events Panel Header Area 
 

4.12.2 REPORTED ALARM DETAILS  

Columns of the Alarms & Events panel display various properties of the messages: 

 
• Date & Time – Displays when message was first reported 

• Type – Identifies if notification is an alarm or an event, and the severity if it is an alarm.  

• Message – Provides a description of the alarm or event 

• Frame-Slot – Identifies device that initiated the message 

• Name/Alias – Displays the assigned device name or alias of initiating device 

• Duration – Displays elapsed time since the alarm was reported. This entry does not apply to 
event messages.  The duration display increments once each minute until the Fixed check-box in 
the Status column is checked.  

• Status – Contains check-boxes labeled Acknowledged (Acked) and Fixed, whereby the user 
indicates current status of the alarm condition.  This column does not apply to event messages.  
Entering a check in the Acked check box indicates the problem is acknowledged and is 
currently being worked.  Entering a check in the Fixed checkbox indicates that the problem is 
resolved.  Note that devices reporting major alarm conditions that have not been resolved are 
highlighted in red in the device tree.  
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4.12.3 SYSTEM ALARMS  

System Alarms refer to alarms and events generated by the Cattrax application, rather than those reported by 
a device. For example, a “Device Disconnected” message is displayed if for some reason Cattrax cannot 
access the network.  

To configure the severity of system alarms, click on the System Alarms button in the Settings menu.  You 
may configure each system alarm condition to report as a major or minor alarm; or you may select alarms to 
be reported as an event or turned off entirely.  

 

4.12.4 DEVICE ALARMS  

Device alarms are alarms and events reported by managed devices.  For example, a “No Video Reference” 
message is displayed when a signal processing card reports loss of video reference.   

 

 

Occasionally a message may simply indicate a device error as a 
means to prompt the user to open the device identified in the Frame-
Slot and Card column and investigate the problem. 

 

Reported alarm severity may be configured individually for each reporting device.  To configure a device 
alarm, locate and open the device from the Device Tree, select Configuration menu from the Menu Tree, 
then select appropriate sub-menus and/or controls to set desired reporting severity.  

 

4.12.5 ALARM FILTERING &  SORTING  

Filtering and Sorting helps users quickly find an entry in the alarm list.  For example, to find all alarms 
reported for a particular device, click on the column header for the Frame-Slot column to sort the alarm list 
by device IP Address; then scroll through the list to the frame IP of interest to find all alarms reported for 
that device.  Sorting is available for all columns in ascending or descending order. Click on the same 
column header to toggle between ascending and descending order. 

 

 

In order to view most recent reported errors, the alarm list must be 
sorted in Date-Time order. 

 

The alarms list may also be filtered by alarm type – Major, Minor, or Events by clicking on the Type 
column in the Alarms & Events panel area.  

 

4.12.6 BLOCKING ALARMS  

To prevent unnecessary messages being generated from a device, alarms for a particular device may be 
blocked by right-clicking on the device entry in the device tree and selecting the Block Alarms option. This 
option is useful when a device is being installed, configured or reconfigured for use.  



Cattrax PC Based Control Application 
Publication 81-9059-0677-0, Rev. C 

January 2012 

Proprietary Information of PESA  4-16 

 

4.13 DEVICE AND SYSTEM CONFIGURATION M ANAGEMENT  

Functions available through Cattrax save and restore system features allow you to save configuration of 
managed devices, either individually or as an entire system, and use the saved configuration file to restore 
configuration data at a later time - if needed.  Save and restore functions may be accessed from either of two 
menus as shown in Figure 4-13.  The menu bar Save System icon under the Tools menu, as shown on the 
left in Figure 4-13, allows you to only save entire system configuration.  You may use the right-click menu, 
as shown on the right in Figure 4-13, from the Devices View panel to save configuration of only the 
highlighted device or the entire system. 

 

 

Figure 4-13  Save and Restore Menu Options 
 
 

SAVING A CONFIGURATION FILE 
 
To save configuration data for a device, locate and highlight it in the device tree listing.  If you wish to save 
the configuration for a single device, highlight only that device from the tree listing.  To save configuration 
data for multiple devices, click on the device entries while pressing the control (CTRL) key.  Right-click to 
open the menu box and select the Save menu option as shown in the example screen on the right side of 
Figure 4-13.  The Save As dialog box, Figure 4-14, is displayed and prompts you to enter a filename for the 
saved configuration.  Cattrax will recommend a default filename and location for storing the file; however, 
you may enter any filename or directory location of your choice to easily locate and identify the file by its 
associated device or system.  Enter the desired filename and click on the Save button.   



Cattrax PC Based Control Application 
Publication 81-9059-0677-0, Rev. C 

January 2012 

Proprietary Information of PESA  4-17 

 

 
 

Figure 4-14  Save Configuration File Selection 
 
When you have entered the desired filename and location, the Save Configuration dialog box, Figure 4-15, 
is displayed.  This dialog box allows you to select which configuration parameters of the device(s) you wish 
to save in the configuration file.  You may uncheck parameters that are not required to be saved.  Cattrax 
selects all parameters by default.  Click the Save button on the dialog box to save the configuration file for 
the device(s).   

To save configuration data for an entire system, select any device in the device tree, and then select the Save 
System option from the right-click menu; or select the Save System icon under the Tools menu, as shown on 
the left in Figure 4-13. The remainder of the procedure is the same as save configuration for individual 
devices, explained above, except that the save list contains all devices in the system.  
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Figure 4-15  Save Configuration Dialog Box  
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RESTORING A CONFIGURATION FILE 

To restore configuration of a device from a saved configuration file, select the device on the device tree in 
the Devices View panel, right-click to open the menu box and select the Restore menu option.  The Open 
dialog box, Figure 4-16, is displayed and prompts you to select or enter the filename of the saved 
configuration file.  Enter or select the desired filename and click Open. 
 

 
Figure 4-16  Selection of Configuration File 

 

When a file is selected and the Open button is clicked, Cattrax automatically checks for hardware 
compatibility between the saved file and the device to be restored and displays the result in the Restore 
Configuration dialog box, Figure 4-17.  You may use the checkboxes to select or de-select any of the 
values you do not wish to be written into the restored configuration file.  If the Source and Destination are 
compatible, click Restore to reload configuration data to the device. Click Cancel to exit the restore 
procedure.  

To restore configuration data to an entire system, select any active device in the menu tree, right-click and 
select Restore System from the menu; or select the Restore System icon under the Tools menu, as shown on 
the left in Figure 4-13.  The remainder of the procedure is identical to the device restore operation except 
the restore list contains all system devices.  
 

 
 

Figure 4-17  Restore Configuration Dialog Box  
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4.14   BATCH CONFIGURATION  

The Batch Configuration feature of Cattrax allows you to simultaneously send commands and operational 
parameters entered or selected on any of the various interactive menu or control screens for a particular 
device type to multiple devices of the same type within the network.  To perform batch configuration, select 
multiple devices of the same type from the device tree by holding the CTRL  key down while clicking on 
device entries.  Then click on the Batch Configure button in the device tree panel header area, as shown in 
Figure 4-18.  The selected device menu will open in the menu tree panel.  Use the control and configuration 
menus to configure selected devices simultaneously.  Exit batch configuration mode by clicking any device 
entry in the Devices View listing or by clicking the batch configuration icon in the Devices View menu.  

 
 

 
 
 
 
 
 
 
 

Figure 4-18  Batch Configuration Selection 
 

4.15 DEVICE SOFTWARE UPDATE CAPABILITY  

Many PESA devices that you will control through Cattrax contain board-resident software or device code, 
stored in flash memory, which from time-to-time may need to be updated.  Cattrax makes the entire process 
of downloading firmware updates simple and straight-forward using the Download function available 
through the Tools menu.   

As new software updates for PESA products are released, they are available through PESA Customer 
Service or from the website at www.pesa.com. When you receive an update for a PESA device, the code is 
delivered to you as a single file with a filename descriptive of the update and ending with a .PBN extension; 
you must copy the file to the hard drive of the computer running Cattrax.  It makes no difference to the 
download operation where the file is stored, and you may use any directory structure you like.  For 
convenience, PESA recommends that you make a specific directory on your hard drive to store only .PBN 
files.  Whatever directory structure you use, you will have to access this directory as part of the download 
process.   

The following procedure outlines the steps for downloading firmware to PESA devices.  For this example, 
we have created a directory on the host PC named “SavedConfigs” to store the update files; and we will use 
a Vidblox device in the sample screens, but the procedure is the same for any device.  

 

1. Copy the .PBN update file to the desired directory on the host PC hard drive. 

2. Open the Tools menu on Cattrax and select the Download function as shown by Figure 4-19. 

Refresh
View

Batch
Configure

Locate
Device

Offline
Configuration

Alarm
Alert
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Figure 4-19  Download Icon 
 

3. Selecting download opens the Open Flash Update File dialog box as shown by Figure 4-20. 
 

 

Figure 4-20  Flash Update Dialog Box 
 

4. Navigate to the hard drive directory containing the .PBN update file you wish to download and 
select it from the listing.  Ensure that the proper file is selected and that the correct filename is 
shown in the File Name: box and click Open to continue.  For this example we have selected the 
.PBN file that updates FPGA code in a Vidblox Receiver module to version 3.16. 

5. The Download Flash File dialog box, shown in Figure 4-21, opens with a display of all devices 
under control of Cattrax that use the selected .PBN file.  On the example screen, note that only 
Vidblox receiver modules on the network are displayed as candidates for installing the update file. 
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Figure 4-21  Download Flash Selection Box 
 

6. Each candidate device is identified by type, its alias name on the network and its IP address.  The 
Version column identifies, by individual module, the version of the code currently installed on that 
particular device; and the right-most column, labeled Select Action, displays the action the selected 
.PBN file would have on each device if downloaded, and allows you to select for each individual 
device whether or not you want to download and install the selected file.  For each device you will 
be prompted whether installing the update would take the device to an earlier code version 
(Backrev), re-install a new load of the current code version (Reload) or Upgrade the device to a 
newer code version (Upgrade). 

 

7. Place a check in the box beside the indicated action for the devices you wish to receive the file 
download and installation.  Click the Download button to initiate software update or click the Exit  
button to leave the screen with no changes.  

 

 

Downloading software code to most PESA devices will take the device off-
line for the duration of the download and will re-boot the device after 
installation. 

 

8. Download and installation is automated and a progress bar is displayed as the procedure is 
performed.  With many devices a re-boot of the device is required and is automatically initiated 
after installation of the new code.  
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4.16 CATTRAX DIAGNOSTICS TOOLS 

Cattrax provides built-in diagnostics capabilities that allow program folders containing system data to be 
combined into a single .ZIP file for easy communication with PESA Customer Service, should it ever be 
necessary.  This automated process makes it much easier for PESA technicians to acquire the data necessary 
for analysis to assist you if you have a problem with installation or operation of the Cattrax application. The 
following procedure outlines the steps for generating a diagnostics .ZIP file: 

 

1. Select the Diagnose function from the Settings menu as shown by Figure 4-22 to open the Save As 
dialog box, Figure 4-23. 

 

 

Figure 4-22  Diagnostics Menu Icon 
 

2. Enter or navigate to the directory where you want to store the diagnostics file.  Cattrax will insert a 
default filename for the .ZIP file; you may enter another filename if desired.  When the directory 
location and filename are entered, click the Save button to write the data file.  Click Cancel to abort 
the diagnostics operation. 

 

 

Figure 4-23  Diagnostics File Dialog Box 



Cattrax PC Based Control Application 
Publication 81-9059-0677-0, Rev. C 

January 2012 

Proprietary Information of PESA  4-24 

 

4.17 M ENU BAR CONTROLS 

Controls located on the menu bar header, Figure 4-24, allow you to configure the application and set 
preferences. There are four items in the menu: Settings, View, Tools and Help.  

To display one of the submenus, single-click to open it temporarily, or double-click to keep the submenu 
display open.  The open display may be toggled by double-clicking on the menus.  

 

 
Figure 4-24  Cattrax Menu Bar 

4.17.1 SETTINGS MENU 

Functions available through the Setting menu, Figure 4-25, allow you to set internal configuration and other 
operational parameters of Cattrax.  
 

 

Figure 4-25  Cattrax Settings Menu 
 

• Global Settings - Clicking the Global Settings entry of the Settings menu opens the Global Setting 
box, Figure 4-26.  The following functions are available through selections on the Global Settings box:  

 

 
Figure 4-26  Cattrax Global Settings Menu 
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- System Alarm – Clicking the System Alarm button displays the System Alarm Define dialog 

box. To change current setting of an alarm type, select the box in the Type column and use the 
drop-down to select between available options, as shown in Figure 4-27.   

 

 
 

Figure 4-27  System Alarm Configuration 
 
- Work Mode – The Mode text box has a pull-down menu with choices for normal operation of 

Cattrax or Demonstration Mode.  When demo mode is selected, Cattrax prompts you to exit and 
re-start the application.  Changing between normal operation and demonstration mode always 
requires a re-start of the application.  Demonstration mode allows full simulation of various 
menu screens for a variety of PESA devices without affecting changes to equipment connected 
to the network.  Demo mode is discussed further in Paragraph 4-19.   

- System Log – Choices available through the Log level pull-down menu define how much 
information is presented by the log file.  The log file records the operation of Cattrax, to help 
debug problems. 

- Authority - Cattrax can operate in a password protected mode to limit user capabilities unless a 
valid password is entered.  Selecting Password Mode from the Global Settings box activates 
password protection.  The procedure for using password mode is discussed in Paragraph 4-18.   

 

• Network Preferences - Clicking Network Preferences opens the Host Network Configuration box 
that allows you to view or modify network communication parameters for Cattrax.  In many 
installations, PESA devices may reside on subnets different from one another within the network. It is 
also possible that the host PC might contain multiple network interface devices, as would be the case, 
for example, if it contains both an Ethernet cable NIC and a wireless adapter.  Cattrax allows you to 
easily select both the network interface device it uses and the subnets on which it communicates 
through network preference settings.  Refer to Paragraph 4.2 of this User Manual for a complete 
discussion of network configuration options and capabilities.  

• Diagnose - Clicking the Diagnose option initiates the Cattrax diagnostics file generation function.  
Refer to Paragraph 4.16 of this manual.   
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4.17.2 VIEW MENU 

Control options contained in the View Menu, Figure 4-28, allow the user to configure Cattrax display. 

 

 
Figure 4-28  View Menu Controls 

 
• Show/Hide - Disable or enable corresponding display windows.  Console View is used only with a 

USB connected device; if no device is present on the USB port, this menu entry is inactive, as shown in 
Figure 4-28, and cannot be selected.   

 
• Window  - Is a group of controls to select window layouts as follows: 

 
- Tile Horizontally and Tile Vertically  - Control tiling of device menus within the display area  
 
- Default Layout - Restores layout of all display panels to default setting  
 
- Close All - Closes all the opened devices in the device menu display area  

 
• Switch Windows - Allows you to switch to a display of the next open device in the Device Menu 

display window.  
 
• Console – Opens the console window for a USB connected device.  Clicking this button performs the 

same action as selecting the Console View checkbox from the Show/Hide menu.   
 
• Appearance - Selects overall display style - blue is the default selection; options in this menu also 

allow changing the display orientation from right to left.  
 

4.17.3 TOOLS  

• Save System & Restore System - Allows you to save configuration data for the entire system and 
initiate restoration of a saved configuration to the system, refer to Paragraph 4-13. 

• Offline Configuration  – Allows you to create or modify configuration files for PESA system 
controller devices without Cattrax having to be attached to the device.  

• Download - Clicking Download allows you to download firmware and/or software code updates to 
flash memory of many PESA devices.   Refer to Paragraph 4.15.  

• License Control – Opens menus for obtaining and installing license keys for certain PESA software 
applications such as PNet Soft Panels.  Specific licensing procedures are provided in the User Guide 
for the particular software app. 
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4.17.4  HELP  

Help menu functions allow you to open an on-screen Cattrax User Manual, and also display current version 
data of the Cattrax software.  

 

4.18 PASSWORD PROTECTED OPERATION  

By default Cattrax operates in non-password mode where all functions are accessible to all users. It is 
possible to configure Cattrax to operate in password mode, which restricts configuration menus in the menu 
tree to read-only mode unless a valid password is entered.  Activate password mode as follows:  

 

1. Open the Settings menu and click on the Global Settings entry to open the Global Settings box 

2. Select Password Mode option as shown in Figure 4-29.  The pop-up Warning box prompts you to 
confirm the mode change.  Click Yes to activate password mode. 

 

 
Figure 4-29  Password Mode Confirmation Box 

 
3. When Password Mode is active, a password login prompt appears on the right edge of the main 

menu header as shown in Figure 4-30. 

 

 
Figure 4-30  Password Prompt   
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4. In order to login to Cattrax with password protection active, click on the password prompt and 

click again on the Login button as shown in Figure 4-31.  Enter Username “Engineering”  (case 
sensitive) and Password 999 in the spaces provided on the Login dialog box as shown in Figure 4-
32.  Click OK  to open full access to Cattrax functions.   

 

 
 

Figure 4-31  Password Login Button 
 
 

 
 

Figure 4-32  Password Dialog Box 
 
When Cattrax is operating in password mode, the message “Welcome: Engineering” appears in place of the 
login prompt on the menu bar header.  In order to cancel password mode, you must be logged in as 
“Engineering.”  Open the Settings menu and unclick the Password Mode option.   

Password mode allows you to select an Auto Logout, if desired.  To activate this feature, click the Auto 
Logout box in the Authority panel.  Auto logout after 5 minutes is the default value; however, you may 
enter any desired time out from 1 minute to 999 minutes. 

If a user has not logged in as “Engineering” when password mode is active, the following restrictions are 
enforced: 

 
• All controls in the Configuration menu(s) are grayed out, allowing the user to see current 

settings but not make any changes.  

• The Save & Restore function is disabled to prevent unauthorized or unintended changes to 
saved system configuration data.  

• The Save for Auto-Restore function is disabled to prevent unauthorized or unintended 
changes to saved configuration data for automatic restoration. The user is still allowed to 
enable or disable auto-restoration mode.  

• It is not possible to switch back to non-password mode  

• It is not possible to use Auto-Logout setting, which controls the inactivity logout timer for 
“Engineering” user sessions.  
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4.19 DEMONSTRATION M ODE  

Cattrax features a demonstration mode that allows you to fully simulate operation of various menu screens 
for a variety of PESA devices without affecting any changes to equipment connected to the network.  This 
feature is invaluable for learning available control and monitor functions for specific devices, or for training 
operators who may not be familiar with Cattrax how to navigate and operate various functions of the 
application. 

 

4.19.1   ACTIVATING DEMONSTRATION MODE 

Activate Demonstration Mode as follows: 

1. Click on the Settings menu header and click the Global Settings icon as shown in Figure 4-33.  The Global 
Settings box is displayed as shown in Figure 4-34. 

 

 

Figure 4-33  Settings Menu Icon 
 

2. Click the pull-down menu in the Work Mode box and select “Demonstration Mode” as shown in Figure 4-
34, then click OK to initiate the command. 

 

 
 

Figure 4-34  Work Mode Selection 
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3. The text box shown by Figure 4-35 displays and prompts you to exit and re-start the Cattrax application in 
order to initiate demo mode.   

 

Figure 4-35  Work Mode Restart Prompt 
 

4. When you have re-started the program, Cattrax comes up in demonstration mode as indicated by the header 
text as shown in Figure 4-36. 

 

 
Figure 4-36  Demo Mode Example Screen 
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4.19.2   USING DEMONSTRATION MODE 

When run in demonstration mode, Cattrax emulates actual control and monitor screens through the use of 
templates that are selected and loaded through the Settings menu; each PESA device available for demo 
mode has an emulation template.  When a template is created the device type, alias and simulated IP address 
are shown in the Devices View window, as shown in Figure 4-36 - just as with an actual operating Cattrax 
configuration.  It is possible to have multiple templates loaded and switch between operating screens of each 
template.  If no templates are displayed in the devices view window, you will need to create at least one 
template as discussed in Paragraph 4.19.4.  Any templates that were created in a previous demo mode 
session, and were not deleted at the end of the previous session, are displayed when demo mode is activated.  
If no templates have been created, or if templates were deleted in previous sessions, the devices view 
window will be empty.    

Select a template from the listing by clicking on the entry.  Menu, control and monitor screens for the 
emulated device appear and function exactly as the “live” screens.  You may make any changes and 
exercise any functions you wish with no effect whatsoever on actual operating hardware attached to the 
network.  Specific operating screens for a given device are introduced and discussed in the Technical 
Manual for the device.   

 

4.19.3   TEMPLATE MANAGER DIALOG BOX 

Emulation templates are created and modified through commands of the Template Manager dialog box.  
Whenever a template is created or modified it is automatically promoted to the Devices View window when 
you exit from the Template Manager box.   Prior to using demo mode, at least one emulation template must 
be created and appear in the Devices View window.  Access the Template Manager dialog box as follows: 

 

1. Click on the Settings menu and click the Template icon, as shown by Figure 4-37.  Note that the Template 
menu selection icon only appears when Cattrax is operating in demo mode.  

 

 

Figure 4-37  Template Icon Location 
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2. Clicking the template folder opens the Template Manager box as shown by Figure 4-38.  When the manager 
box is first opened any templates created during previous demo mode sessions are displayed.  If no 
templates have been previously created, or if they were deleted at the conclusion of the previous session, the 
box will be empty.   Anytime a new template is created, the device name, type of template and the simulated 
IP address appear in the box as shown.     

 

 

Figure 4-38  Example Template Manager Screen 
 

The following buttons appear on the Template Manager box: 

 

• New – Allows you to create a new emulation template for a PESA device, refer to Paragraph 4.19.4 

• Open – Select a template from the Device Name list and click the Open button to open the 
Template Information dialog box for the selection 

• Delete – Deletes the selected template from the Device Name listing 

• Exit  – Exits the Template Manager window 
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3. If you wish to modify a template already appearing in the list, highlight the desired template in the Template 
Manager listing and click the Open button at the bottom of the box.  This opens the Template Information 
dialog box for the selected template.  Make any desired modifications to the template and click Save to 
change the template file and close the Template Information box.  

4. If you wish to create a new template for a PESA product and add that template to the listing for access, 
follow the procedure in Paragraph 4.19.4. 

5. To remove a template from the listing, highlight the template you wish to delete and click the Delete button 
at the bottom of the box.  The template you delete is removed from both the template manager listing and 
the Devices View window. 

6. When you have created or modified any templates you wish to use for demonstration, or deleted templates 
you wish to remove from the active template listing, close the Template Manager box by clicking the Exit  
button.  When you close the Template Manager box, the Devices View window is automatically updated to 
display templates appearing on the managed template list. 

4.19.4   CREATING A NEW EMULATION TEMPLATE  

If the PESA device you wish to emulate in demo mode does not appear in the template manager list, you 
can create a new template as follows: 

 

1. Click the New button at the bottom of the Template Manager box as shown by Figure 4-38.  The Template 
Information dialog box, Figure 4-39, is displayed. 

 

 

Figure 4-39  Example Template Information Screen 
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2. Open the pull-down menu in the “Device Type” text box and from the listing select the PESA device type 
for which you wish to create an emulation template.  In our example, we have selected the “Vidblox” entry.  

With the desired device type shown in the box, enter a simulated Device IP address and Device Name for 
the device in the Template Information box as shown in Figure 4-40.  Note that this is a SIMULATED IP 
address and device name used by demo mode only.  The emulated device does not communicate over the 
Ethernet with any external devices, and the address you enter here has no effect on actual network 
addresses.  Cattrax does require you to enter a simulated IP address for each device type template you 
create.  Entering a Device Name is optional, but when you do enter a device name it further identifies the 
template in the Template Manager and Devices View listings.   

  

 

Figure 4-40  Example Template Information Entry 
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Information displayed in the “Device” and “Information” columns varies depending on the type of PESA 
device you choose for emulation.  In our example, we are emulating a Vidblox module.  Anytime you make 
a device type selection, data pertinent to the device appears in the Device column.  Additional information 
to further define the listed device is entered through a pull-down menu in the Information column. 

An example of device data entry using a PESA Quadbox module, is shown in Figure 4-41.  Notice when we 
select Quadbox as the Device Type, the prompt “Version” is placed in the Device column.  Using the pull-
down menu in the Information column, we can further specify the type of Quadbox we wish to emulate.  In 
this example, we have chosen a transmit module loaded with firmware version 1.0.0. 

 

 

Figure 4-41  Example Information Pull-Down Menu   
 

 

3. Enter data for the desired emulation template as discussed in the paragraphs above. 

4. Click Save to add newly created template to Template Manager listing.  You may create multiple instances 
of each device type provided each is identified by a unique simulated IP address and, optionally, a unique 
device name.  Click Cancel to abort template creation process.  By clicking either Save or Cancel, the 
template information screen closes to the Template Manager screen. 

5. Click Exit  on manager screen to exit template management function.  The newly created template is 
automatically added to the Devices View window. 
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4.19.5   LEAVING DEMONSTRATION M ODE 

When you have completed a demo mode session, you may choose to leave the templates available in the 
devices view window for the next demo mode session, or you may delete any or all of the templates as 
discussed in Paragraph 4.19.3.   

Leave demo mode and return to Cattrax as follows: 

1. Click on the Settings menu header and click the Global Settings icon as shown in Figure 4-33.  The Global 
Settings box is displayed as shown in Figure 4-34. 

2. Click the pull-down menu in the Work Mode box and select Normal Mode as shown in Figure 4-34, then 
click OK to initiate the command. 

3. The text box shown by Figure 4-35 displays and prompts you to exit and re-start the Cattrax application in 
order to leave demo mode and return to normal mode. You must exit and re-start the program to initiate a 
change of operating mode.   

4. When you have re-started the program, Cattrax comes up in normal operating mode.  All menus and screens 
are functional in normal mode and WILL affect changes to PESA devices on the network.  Note that demo 
templates, simulated IP addresses and device names are hidden during normal mode operation. 
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Chapter 5 In the Event of Difficulty 
 

5.1 PESA CUSTOMER SERVICE  

If you have questions about, or are experiencing any difficulty with, your Cattrax software control 
application, contact PESA’s Customer Service Department.  Technicians are available to assist you 24 hours 
a day, seven days a week. 

 

 



 

 

 

 


